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Overview
FxEdit for Windows 95/NT is a small file utility that will allow you to view and modify binary disk files.

String Searches
FxEdit can also be used to search for specified hexadecimal and ASCII text strings.

Drag & Drop
Files can be quickly opened and viewed by simply dragging a file’s icon to the FxEdit window.

Print Files
FxEdit will also print binary files in a variety of user-specified formats.

Desktop Locations
FxEdit’s location on the desktop is saved when the program is exited. Whenever you start FxEdit it will reappear on the desktop 
where you last placed it. FxEdit property sheet locations are also stored and reused the next time they are opened.

Taskbar Tray
FxEdit for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. This 
option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing FxEdit
Installation
To install FxEdit for Windows 95/NT on your computer simply create a new, empty folder and place the files; FXEDIT.EXE, 
FXEDIT.HLP and FXEDIT.CNT there.

FXEDIT.EXE - The FxEdit Application
FXEDIT.HLP - The Windows 95/NT Help File
FXEDIT.CNT - The Help Contents File

To integrate FxEdit for Windows 95/NT with the MS Windows Explorer select the FxEdit Explorer Setup property sheet while 
FxEdit is running.

Note If you have an earlier version of FxEdit for Windows 95/NT installed on your computer, simply replace the FXEDIT.EXE, 
FXEDIT.HLP and FXEDIT.CNT files with the newer versions.

Note The FXEDIT.INI file is no longer used and can be deleted. The various application settings specified in the FxEdit Options 
property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT System 
Registry.

Note Some earlier versions of FxEdit for Windows 95/NT included a FXEDIT.WRI documentation file. This file has been replaced
by the FXEDIT.HLP file and can now be deleted.

Warning If you rename the FXEDIT.EXE file you must also rename the HLP file using the same basename. For example if you 
change the FxEdit application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the 
FXEDIT.CNT file however. The HLP and CNT files must reside in the same folder as the FxEdit application file itself.



Configuring FxEdit
FxEdit Options
Select the File | Options menu item to display the FxEdit Options property sheet. This window will allow you to change the 
various FxEdit program settings listed below.

Launch Multiple Instances
Check this item to allow more than one instance of FxEdit to be run on the desktop.

Reopen the Last File Used at Startup
Check this box to reopen the last file used when FxEdit is launched.

Open Locked Files as Read-Only
Check this box to open write protected files as read-only. If this item is not checked and a locked file is opened you will be 
prompted to load the file as read-only.

Show Tool Bar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Place Icon in Taskbar Tray
Check this item to display a small FxEdit program icon in the Taskbar Icon Notification Tray. If this item is selected and the 
FxEdit window is minimized a button will not be added to the Taskbar, to restore the FxEdit window on the desktop press the 
small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running programs.

Note When this option is selected, clicking on the Close box in the upper right-hand corner of the window title bar will 
minimize FxEdit instead of closing the application. To quit FxEdit right-click with your mouse on the FxEdit icon in the Taskbar 
tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Confirm Program Exit
Check this item to confirm quitting FxEdit for Windows 95/NT. When this option is selected you will be prompted to confirm 
your intention to exit FxEdit and return to the MS Explorer desktop. This item is useful if you run FxEdit from the tray and wish 
to avoid accidental exits when you right-click on the FxEdit tray icon.

Display the Full ANSI Character Set
Check this item to display the entire ANSI character set, codes 32-255. If this item is not selected only ASCII character codes 
between 32-127 will be displayed.

Record Numbers
Check this box to include file record numbers when printing binary file reports.

ASCII Character Strings
Check this box to include ASCII character strings when printing binary file reports.

Hexadecimal Data Values
Check this box to include Hexadecimal data values when printing binary file reports.

Warning Sounds with Dialog Boxes
Check this box to play a short beep sound when FxEdit displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of FxEdit program options. When you press this button the FxEdit 
Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the FxEdit Options property sheet without making any changes. If you have made any changes to 
the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the FxEdit Help window and go directly to the Configuring FxEdit topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the FxEdit Options 
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Configuring the Tools Menu
Configuring the Tools Menu
FxEdit    for Windows 95/NT allows up to nine (9) applications to be added to the Tool menu. To define a tool select the Tools | 
Define Tools menu item. A property sheet will be displayed allowing you to specify the various tool parameters for the tool menu
item you are defining.

Tools
Use this list dropbox to select the tool menu item you would like to define or modify. Tool menu items that are not defined will 
have a title of Undefined. The Tool menu item properties for the tool you have selected will be reflected in the window below.

Name
Enter a short name to be used as the tool menu item name. This name will appear on the Tools menu.

Active
Check this box to enable the tool menu item. If this item is not checked the tool name will appear on the Tools menu but the 
item will be disabled (grayed).

Minimize FxEdit    on Tool Launch
Check this box to minimize to the FxEdit main program window to an icon on the MS Explorer Taskbar or Icon Notification 
Tray. This option is useful to reduce screen clutter when FxEdit is used with other applications.

Program
Enter the name of the program you would like to associate with the tool menu item. Use the entire path when specifying a tool
menu item, or press the browse button [...] to the right of the entry field to select an application using the standard MS 
Windows file browser.

Command
Enter any option command arguments this tool definition may need. This is an optional item and may be left blank if you 
simply need to launch a program without any additional command arguments.

Run
Specify the window size using this command. Tools can be launched with a normal sized main window, or a minimized or 
maximized window.

Ask for Arguments
Check this box to be prompted for runtime command line arguments when a tool is launched

Working Directory
If this entry is filled with a directory name, the folder you specify will be selected and made the default working directory before
launching the menu item tool. Press the browse button [...] to the right of this entry field to automatically select a folder using 
the folder browser dialog box.

OK
Press this button when you have completed your selection of Tool settings. When you press this button the Tool 
Customization property sheet will be closed and your tool settings will be saved.

Cancel
Press this button to close the Tool Customization property sheet without making any changes. If you have made any changes 
to the tool    settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Delete
Press this button to delete the currently displayed Tool settings. You will be asked to confirm this command before the current 
tool is deleted.

Help
Press this button to open the FxEdit Help window and go directly to the Configuring the Tool Menu topic.

Tip Use the Ctrl+1 through Ctrl+9 shortcut keys to quickly invoke the tool menu items you have defined.

Note The Tool Menu settings you have selected will be saved when you press the OK button. The desktop location of the Tool 
Customization window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



FxEdit Explorer Setup
FxEdit Explorer Setup
Select the Help | Setup menu item to display the FxEdit Setup property sheet. This window will allow you to integrate FxEdit for 
Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS Explorer shortcuts.

Create a Start Menu Item
Check this item to create a FxEdit Start Menu entry. The FxEdit for Windows 95/NT program will be located in the Software by
Design folder on the Programs menu. This item will be disabled (grayed) if a FxEdit item already exists in the Software by 
Design folder.

Remove this Start Menu Item
Check this item to remove the FxEdit entry located in the Software by Design folder on the Programs menu. This item will be 
disabled (grayed) if a FxEdit item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a FxEdit for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a FxEdit desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the FxEdit for Windows 95/NT program icon from the Explorer desktop. This item will be disabled 
(grayed) if a FxEdit desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run FxEdit for Windows 95/NT whenever Microsoft Windows is started. This option creates a 
FxEdit program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a FxEdit startup item 
already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove FxEdit from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a FxEdit 
startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the FxEdit 
Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the FxEdit Explorer Setup property sheet without creating or removing any MS Explorer shortcuts.

Help
Press this button to open the FxEdit Help window and go directly to the FxEdit Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to work with the binary files used by FxEdit. A short description of each item follows:

Open
Opens an existing binary file, and loads it for editing or viewing. When this item is selected the standard MS Windows 
Explorer file browser will be displayed, use this window to select the disk file you wish to work with. Check the Open as 
Read-Only box to load files for viewing only. The Ctrl+O shortcut can be used for this command.

Properties
Displays a small window showing file properties for the currently selected binary file. This window will display the 
document’s file name, folder location, size, last modification date and file access permissions. The Alt+Enter shortcut can 
be used for this command.

Close
Closes the currently active disk file. If the file has been edited you will be prompted to save or discard the changes before 
closing. The Ctrl+W shortcut can be used for this command.

Save
Saves changes made to the currently selected disk file. This menu will be disabled (grayed) if no changes have been made
to the file since it was last loaded or saved. The Ctrl+S shortcut can be used for this command.

Save as Hex Data
Saves the currently active disk file as an ASCII Hexadecimal text file. This option is useful if you need to create files 
suitable for use by Hexadecimal to Binary conversion utilities. When this item is selected the standard MS Windows 
Explorer file browser will be displayed, use this window to specify a name for the ASCII Hexadecimal text file being created.
The ASCII Hexadecimal files you create can be optionally padded with spaces separating each individual byte as it is being
written. The Ctrl+D shortcut can be used for this command.

Save a Copy As
Saves the currently active disk file with a new name. When this item is selected the standard MS Windows Explorer file 
browser will be displayed, use this window to specify a new name for the current file. The Ctrl+A shortcut can be used for 
this command.

Discard
Use this item to discard editing changes made to a disk file, and reload the previous version from disk. This item will be 
disabled (grayed) if the file currently being edited has not changed since it was last saved or loaded. The Ctrl+R shortcut 
can be used for this command.

Printer Setup
Opens the standard MS Windows 95/NT Printer Setup dialog box, allowing you to select a printer and set various other 
printer options.

Print
Prints the currently selected binary file on your system’s printer. A dialog box will appear before printing is started to allow 
you to select the printer to be used and various other printer options. The Ctrl+P shortcut can be used for this command.

Options
Opens the FxEdit Options property sheet and allows you to change FxEdit program settings. Use this command to 
configure the FxEdit program.

Recent Files
This command displays a sub-menu containing up to 9 recently edited files. Select a file name from this list to quickly 
reopen a recently edited binary file.

Exit
Closes the FxEdit program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of binary files. A short description of each item follows:

Edit Hex
Begins editing the currently selected binary disk file record in the Hexadecimal mode. The editing cursor will change to a 
red block to specify the byte currently being edited. Enter the hexadecimal characters 0-9 or A-F in this editing mode. The 
red editing cursor will automatically move to the next byte in the block as hexadecimal values are typed. Use the arrow 
keys to skip bytes without making changes and the Esc key when you have completed editing. The Ctrl+K shortcut can be 
used for this command.

Edit String
Begins editing the currently selected binary disk file record in the ASCII/ANSI mode. The editing cursor will change to a red 
block to specify the byte currently being edited. Enter normal ASCII/ANSI characters in this editing mode. The red editing 
cursor will automatically move to the next byte in the block as characters are typed. Use the arrow keys to skip bytes 
without making changes and the Esc key when you have completed editing. The Ctrl+E shortcut can be used for this 
command.

Stop
Stops or cancels the currently active editing mode. The cursor will change back to a yellow block when this command is 
invoked. The Esc shortcut can be used for this command.

Tip Commonly used Edit commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change FxEdit display options. These items provide a means of changing the 
FxEdit window appearance. A short description of each item follows:

Customize Toolbar
Use this command to customize the FxEdit for Windows 95/NT toolbar ribbon. The standard MS Windows Toolbar 
Customization dialog box will be opened and displayed when this command is selected.

Go to Record
Use this command to go directly to a specified disk file record. A small dialog box will appear when this command is 
invoked. Enter the record number of the disk file block you wish to view and then press the OK button. You may enter 
record numbers as either decimal or hexadecimal values. The Ctrl+G shortcut can be used for this command.

Top of File
Use this command display the first record block in the current file. The Ctrl+PgUp shortcut can be used for this command.

Previous Record
Use this command display the previous record block in the current file. The PgUp shortcut can be used for this command.

Next Record
Use this command display the next record block in the current file. The PgDn shortcut can be used for this command.

End of File
Use this command display the last record block in the current file. The Ctrl+PgDn shortcut can be used for this command.

Minimize
Minimizes the FxEdit window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the FxEdit window top most on the desktop. When this item is checked the FxEdit window will 
float above all other non-topmost windows on the desktop. This item is useful if you normally run FxEdit with a small 
window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this command.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Search Menu
Search Menu Commands
The Search menu provides commands used to search for specified strings in the currently active binary disk file. A short 
description of each item follows:

Find Hex
Opens the Find Hexadecimal dialog box and allows you to specify the Hexadecimal string to be used for a file search. The 
F8 shortcut can be used for this command.

Find String
Opens the Find String dialog box and allows you to specify the ASCII/ANSI string to be used for a file search. The F2 
shortcut can be used for this command.

Find Next
Use this command to find the next occurrence of the string specified. The F3 shortcut can be used for this command.

Tip Commonly used Search commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Tool Menu
Tool    Menu Commands
The Tools menu provides commands used to launch FxEdit custom tools. The custom tools you have defined can easily be 
launched using this menu.

The upper region of this menu contains room for up to 9 custom tool menu items. To define a custom tool menu item use the 
Tools | Define Tools menu command and then select the tool you wish to define.

Tip Commonly used Tool commands can be invoked using the shortcut keys; Ctrl+1 – Ctrl+9.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with FxEdit operations. A short description of each item follows:

Contents
Opens the FxEdit Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens FxEdit Help and displays the Search window. You can use this window to search for specific FxEdit help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the FxEdit Shareware Registration Wizard. This wizard allows you to register    FxEdit for Windows 95/NT for 
authorized use.

Setup
Displays the FxEdit Explorer Setup property sheet. This window provides options to integrate FxEdit with the MS Windows 
Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software by Design web site on the Internet.

About FxEdit
Displays the FxEdit splash box. This window contains program information, the current version of FxEdit you are running 
and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Customizing the Toolbar
Customizing the Toolbar Ribbon
The FxEdit toolbar ribbon can be customized by selecting the View | Customize menu item. The standard MS Windows 95/NT 
Toolbar Customization dialog box will be opened when this command is invoked. Use this window to add and remove FxEdit 
toolbar buttons as well as to change the order that the buttons appear on the toolbar ribbon.

Tip you can also move and delete toolbar buttons without opening the Toolbar Customization dialog box by simply shift-clicking 
with your mouse and dragging the button to a new location on the FxEdit toolbar ribbon itself. To delete buttons shift-click and 
drag the button off of the FxEdit toolbar ribbon.

Note Some versions of MS Windows 95 redraw the toolbar ribbon height incorrectly after customization, if this happens exit 
FxEdit and restart it again to restore the proper toolbar ribbon height.

Available Buttons
This list will contain the buttons available for adding to the FxEdit toolbar ribbon. Only buttons not currently installed on the 
toolbar ribbon will be displayed in this list.

Toolbar Buttons
This list will contain the buttons currently installed on the FxEdit toolbar ribbon.

Add
Press the Add button after selecting a toolbar button from the Available list. The tool button you have selected will be added to
the FxEdit toolbar ribbon at the current selection point.

Remove
Press the Remove button after selecting a toolbar button from the Toolbar list. The tool button you have selected will be 
removed from the FxEdit toolbar ribbon.

Close
Press the Close button to finish toolbar customization. The selection of toolbar buttons that you chose to include will be saved
and reloaded whenever FxEdit for Windows 95/NT is started.

Reset
Press the Reset button to restore the FxEdit toolbar ribbon to its original default settings.

Help
Press the Help button to open the FxEdit Help file and go directly to the Customizing the Toolbar topic.

Move Up
Use this button to move the currently selected button up one place in the toolbar button list. The currently selected button will 
appear one place to the left on the actual FxEdit toolbar ribbon when this command is used.

Move Down
Use this button to move the currently selected button down one place in the toolbar button list. The currently selected button 
will appear one place to the right on the actual FxEdit toolbar ribbon when this command is used.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used FxEdit menu commands can also be quickly invoked by pressing a button on the toolbar ribbon displayed 
at the top of the main window.

These buttons work exactly the same way as the corresponding menu items that they duplicate.

The number of buttons and their order on the toolbar ribbon may differ from the following description if you have customized the 
FxEdit toolbar ribbon.

Open - Open a file

Save - Save changes made to a file

Close - Close the current file

Save Copy - Save a copy of the file

Properties - Show file properties

Print - Print the current file

Edit Hex – Edit file using hexadecimal

Edit String – Edit file using strings

Stop – Stop editing

Go To – Go to the specified record

Top of File – Display the first block

Previous – Display the previous block

Next – Display the next block

End of File – Display the last block

Find Hex – Search for a hex string

Find String – Search for an ASCII string

Find Again – Repeat the search

Topmost – Make the FxEdit window topmost

Options - Open the FxEdit Options dialog

Help - Open this Help file

About - Show FxEdit splash box

Tip If the Show ToolBar Tips option is selected a small popup tip window will appear when the mouse pointer is placed over a 
button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke FxEdit menu commands without first displaying the menu and then selecting an item 
from it. The most commonly used FxEdit commands can be invoked using the following shortcut keys.

File Menu
Ctrl+O Open an existing disk file
Alt+Enter Show properties for current disk file
Ctrl+W Close the current disk file
Ctrl+S Save changes made to the disk file
Ctrl+D Save as ASCII Hexadecimal data
Ctrl+A Save a copy of the current file
Ctrl+R Discard editing changes
Ctrl+P Print the current disk file
Ctrl+Q Exit FxEdit, and return to the desktop

Edit Menu
Ctrl+K Begin editing using the Hexadecimal mode
Ctrl+E Begin editing using the ASCII mode
Esc Stop editing

View Menu
Ctrl+G Go to the specified record
Ctrl+PgUp Display the first record in the file
PgUp Display the previous record
PgDn Display the next record
Ctrl+PgDn Display the last record in the file
Ctrl+Y Minimize FxEdit to a button or icon
Ctrl+T Make the FxEdit window topmost

Search Menu
F8 Search for a hexadecimal string
F2 Search for an ASCII/ANSI string
F3 Repeat the previous search

Tools Menu
Ctrl+1–Ctrl+9 Run a Tool menu item

Help Menu
F1 Display this Help file



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in FxEdit for Windows 95/NT please feel free to contact me on CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



Release History
FxEdit for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added facilities to save the desktop locations of the Find String and Go To dialog boxes. Added a File Menu item to save 
a copy of the currently loaded file

v2.3 Added an option to place the program icon in the Taskbar notification tray, and fixed several minor bugs.

v2.4 Fixed toolbar ribbon update bug. Added support for screen color settings as specified in the Display Properties dialog. 
Added default user and company name to the splash box.

v2.5 Fixed a printing bug that truncated Hexadecimal data values. Added a drag & drop interface to quickly open and view 
binary files. Added an MS Windows 95/NT Help file. Added MS Windows Explorer Setup facilities. Moved all FXEDIT.INI 
configuration settings to the MS Windows 95/NT System Registry. Added an option to display the entire ANSI character 
set. Added a File Menu item to save the current file as an ASCII Hexadecimal text file. Added options to specify the 
elements included in printed file reports. Search strings are now saved and available the next time FxEdit is launched. 
Moved all strings to the Resource section of the executable.

v2.6 Added facilities to customize the toolbar ribbon. Converted the FxEdit Options dialog box to a three-tab property sheet. 
Fixed a bug that prevented proper window repositioning when the MS Explorer Taskbar was placed along the left edge or
at the top of the desktop and the Auto Hide option was active.

v2.7 Added a Recent Files sub-menu to the File Menu. Added a Tool Menu for user-defined applications and utilities. Fixed 
several minor bugs.

v2.8 FxEdit now behaves like a true Taskbar Tray application. Fixed several minor bugs.

Last Update  March 11th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



System Registry
FxEdit for Windows 95/NT System Registry Key
FxEdit for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are updated 
automatically while FxEdit is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. FxEdit automatically updates registry entries when it exits. If 
you edit these settings make sure FxEdit is not running while you edit them. If FxEdit is currently running your changes will be 
overwritten when FxEdit exits.

FxEdit for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
FxEdit for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. FxEdit will automatically maintain these settings for you. If you do edit
these, you do so at your own risk.



Removing FxEdit
Removing FxEdit for Windows 95/NT
If you find that FxEdit for Windows 95/NT does not meet your needs you can remove it from your computer system by simply 
deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed FxEdit in.

FxEdit.exe FxEdit for Windows 95/NT application program.
FxEdit.cnt FxEdit Help Topics File
FxEdit.hlp FxEdit Help File

If you have opened and used the FxEdit for Windows 95/NT Help files your system may contain the following two (2) files. These
files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely removed.

FxEdit.gid MS Windows Help settings file. This file contains the FxEdit Help window size and desktop location as well 
as any bookmarks you may have created.

FxEdit.fts MS Windows Help word database. This file is created when you build a custom word list for FxEdit Help 
files. This file is used to search for words and phrases in the FxEdit Help files.

FxEdit for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above from 
your system’s hard drive you will have completely removed FxEdit from your computer system.

Note If you have installed FxEdit shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the FxEdit files mentioned above.



Software by Design Web Site
Software by Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"FxEdit for Windows 95/NT v2.8"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering FxEdit for Windows 95/NT
Registering FxEdit
FxEdit for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use FxEdit for Windows 95/NT you are required to register it. If after evaluating FxEdit for 30 days you decide not to 
register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register FxEdit for Windows 95/NT by mailing the Order Form provided with this software. When you register FxEdit for 
Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when FxEdit for Windows 95/NT is first launched.

To register your copy of FxEdit for Windows 95/NT select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered FxEdit for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered FxEdit for Windows 95/NT. If you did not specify 
an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased FxEdit for Windows 95/NT. Refer to the notification letter
that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered FxEdit for Windows 95/NT. When you successfully register your 
copy of FxEdit this box will automatically be unchecked for you. If you wish to see the splash box when FxEdit is launched 
return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete FxEdit for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the FxEdit Help window and go directly to the Registering FxEdit topic.



Purchasing Information
Purchasing Information
FxEdit for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use FxEdit for Windows 95/NT you are required to register it. If after evaluating FxEdit for 30 days you decide not to 
purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register FxEdit for Windows 95/NT by mailing the Order Form provided with this software. When you register FxEdit for 
Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when FxEdit for Windows 95/NT is first launched.

Single User Licensing
Individual users can register FxEdit for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to you 
please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of FxEdit directly from the Software by Design web site on the Internet. Print the FxEdit for 
Windows 95/NT Order Form and mail it with your check to become a registered user of FxEdit for Windows 95/NT.

Site Licensing
FxEdit for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use 
FxEdit on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk and 
entitles you to unlimited free updates and telephone support. You can always download the latest release of FxEdit directly from 
the Software by Design web site on the Internet. Print the FxEdit for Windows 95/NT Order Form and mail it with your check to 
become a registered user of FxEdit for Windows 95/NT.

Corporate Licensing
FxEdit for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and use
FxEdit on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk and 
entitles you to unlimited free updates and telephone support. You can always download the latest release of FxEdit directly from 
the Software by Design web site on the Internet. Print the FxEdit for Windows 95/NT Order Form and mail it with your check to 
become a registered user of FxEdit for Windows 95/NT.



FxEdit for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
5609 West Hadley Street
Milwaukee, WI    53210-1554 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of FxEdit for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of FxEdit for Windows 95/NT may either be used by a single person who uses the software personally on
one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of FxEdit for Windows 95/NT through a network, 
provided that you have obtained a site license for the software covering all workstations that will access the software through 
the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of FxEdit for Windows 95/NT through a 
network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of FxEdit for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software by Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.




